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About this Guide

About this Guide

This document provides the technical instructions and the required data to carry out the installation
and configuration. This document also includes the information you must have for administering the
Application Service Manager (ASM).

Intended Audience

This document is an Administration guide that is intended for system administrators who will install and
manage ASM on their network.

To perform the installation, knowledge of your operating system and network configuration is required.
In addition, you must have the basic skills to install software on server and client.

Related documents:

You can find the documents in the product documentation section of the Infor Support Portal, as
described in "Contacting Infor".

 Infor Enterprise Server Platform Support Matrix

Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and
create a support incident.

If we update this document after the product release, we will post the new version on the Infor Support
Portal. To access documentation, select Search > Browse Documentation. We recommend that you
check this portal periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Introduction

Chapter 1: Introduction

The Application Service Manager (ASM) is an administrative tool that you can use to start and stop LN
or other (partner) application services. You can predefine the application services that the ASM can

start or stop in files in . XML format. An application service that you define with the ASM is called an
instance.

Note:

ASM supports several types of instances. Some instances must be ASM-aware. For example, the
Multiple type must have an integration with the ASM.

You can run ASM on these platforms:

* Windows
 UNIX

For a complete overview of the supported hardware platforms for ASM, see ASM platform OS availability.

The procedure to install and configure ASM:

1 Install ASM.
2 Configure the ASM server.

Definitions, acronyms, and abbreviations

Term Definition

API Application Programming Interface

<home directory > The ASM installation/home directory

ASM Application Service Management

ASM Server The ASM engine that handles start and stop requests and management
requests

ASM Snap-in A graphical user interface for managing the ASM that runs as a snap-in
in the MMC (Windows only)

BSE LN software environment

CMD Command prompt

GUI Graphical User Interface

DLL Dynamic Link Library: A library of executable functions or data for use

by a Windows application.
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Term Definition

DNS Domain Name Server

MMC Microsoft Management Console
XML eXtensible Markup Language

ul User interface

U Installable Unit

Y%variable% A Windows environment variable.
${BSE} A UNIX environment variable
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Chapter 2: Installing the ASM Server

The ASM Server consists of these components:

* The ASM Server.
* Aclient command line interface, (asm_c1i).

For more information about the command line interface, see Management from command line.

Several graphical user interface-based utilities are available to configure and manage the ASM Server.
These utilities are called the ASM configuration (UI) utilities, and run as a snap-in on the Microsoft
Management Console (MMC). For information on how to use these utilities, see Configuring services
and instances.

The common line interface of ASM provides functionality similar to the MMC snap in, AsmSnapin.
Note:
To use the ASM Server, you must:

1 Start the server, as discussed in Starting the ASM server.
2 Configure the server after installation, as described in Configuring services and instances

ASM software components

These tables show all ASM software components for Windows and UNIX environments.

The <home directory> points to the ASM installation directory.

Windows Files and Directories

ASM Server <home directory>\bin\asm srv.exe
<home directory>\bin\asm cli.exe
<home directory>\bin\baanmsg.dll
<home directory>\bin\benttool.dll
<home directory>\bin\rexeccfg.dll
<home directory>\shlib\TssConvert.dll
+ similar named files with . pdb extension

ASM Server sample configuration files <home directory>\1ib\*xml.sample
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Windows Files and Directories

ASM MMC snap-in DLLs <home directory>\bin\AsmSnapin.dll
<home directory>\bin\AsmCfgSnapin.dll
<home directory>\bin\Asm.msc
+ similar named files with . pdb extension

UNIX Files and Directories

ASM Server <home directory>\bin\asm srv
<home directory>\bin\asm cli
<home directory>\shlib\TssConvert.<ext>
where <ext> is OS dependent

ASM Server sample start/stop scripts <home directory>\etc\rc.startasm

<home directory>\etc\rc.stopasm

ASM Server sample configuration files <home directory>\1ib\*xml.sample

Installation of Application Service Manager Server
(Remote)

This section is for UNIX or Linux installations only.

With the ASM Installation Wizard, you can install the software on computers that operate on various
platforms, such as UNIX and Linux. You can find this installation program in the setup folder. The
installation program only runs on Windows.

Prerequisites

» Close all other programs during the ASM installation.
» An ssh daemon must be up and running on the destination server. This is required to use SSH and
SFTP.

Remote install procedure

This section is for UNIX or Linux installations only.
To remotely install the ASM software:

1 Double-click the setup.exe file in the setup folder to start the setup program manually.
The Welcome dialog box is displayed, informing you that ASM will be installed.
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Click Next to continue with the Location dialog box

In this dialog box, you specify to install the software locally or remote. A local installation is on the
computer where you run the ASM Installation Wizard. Remote is on a computer in your network. In
this procedure the software is installed remotely.

Click Remote and click Next. The Host Name dialog box is displayed.

Specify this information:

Host Name
The DNS name of the host computer on which the ASM software must be installed.

Login Name
A user name to gain access to the host computer.

Click Next. The Platform Type dialog box is displayed.

Every platform uses a different LN porting set. This dialog box helps you to determine which porting
set you must use. The installation wizard detects on which platform type you install the ASM software.
One or more platform types that are suitable for your machine can be presented.

Select the platform type and click Next.

Specify this information:

Destination Directory

The path and the name of the directory where to copy the ASM software. This so-called installation

directory, or home directory, of the ASM represents the root directory for all ASM software that you
install during this installation session.

Click Next. The Installation Components dialog box is displayed.
Specify the components to install.

The ASM Installation Wizard installs those components that you select. The other two options with
shap-in are unavailable because these options cannot be installed on non-Microsoft platforms.

10 Click Next.

The Ready to Install dialog box is displayed, which provides a summary of the installation settings.
Check whether the settings are correct.

11 Click Install to start the installation of the ASM software to the specified directory on the selected

computer.

12 When the installation has finished, click Finish to complete the ASM Server installation.

Installation of server (Local)

This procedure is for Windows installations only.

To install the ASM software locally:

1 Double-click the setup.exe file in the setup folder to start the set-up program manually.
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The Welcome dialog box is displayed, informing you that ASM is installed and to close all other
programs.

2 Click Next. The Location dialog box is displayed.

In this dialog box, you specify to install the software locally or remote. A local installation is on the
computer where you run the ASM Installation Wizard. Remote is on a computer in your network. In
this procedure, you install the software locally.

3 Click Local and click Next.

The Host Name dialog box is displayed. The Host Name and the Login Code fields are already
filled.

4 Click Next. The Destination Directory dialog box is displayed.

5 Click Browse to specify the path and the name of the directory in the Destination Directory field,
or click Next to accept the default directory.

The ASM software is copied to this directory. This so-called installation directory, or home directory,
of the ASM represents the root directory for all ASM software that you will install during this installation
session.

Note that you cannot run more than one ASM Server on Windows. If the ASM software is already
installed and found during installation, the ASM software components will be updated. The previous
ASM software version will be overwritten on the directory where the ASM Server was installed. You
must uninstall the existing ASM software before you can install the new software in another directory.
For more information about the uninstall process see Remove the ASM software.

6 The Installation Components dialog box is displayed. Specify which components you want to
install.

The ASM Installation Wizard only installs the components you selected.

7 The Ready to Install dialog box is displayed which provides a summary of the installation settings.
Check the specified settings carefully.

8 Click Install to copy the ASM software in the specified directory on the selected computer.
9 Click Finish to complete the ASM server installation.

Updating an ASM server installation

To update a previous ASM installation, several limitations apply.

On UNIX

To avoid writing permission errors in the directory where ASM was already installed, permit the user
who performed the initial ASM Server installation to run the update.

In addition, set all the ASM files in <home directory>\bin and <home directory>\1ibto
writable. This procedure enables you to prevent installation problems. The required ASM files are
described in the table in .ASM software components on page 8
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On Windows

You cannot install more than one ASM Server on Windows. During an update of a previous ASM Server
installation, you cannot choose a target directory. The directory that was used for the first ASM Server
installation is reused. This directory overwrites the existing binaries and DLLs.

Note that the configuration files are not overwritten or removed. To install ASM in a different directory,
you must first uninstall the ASM Server. For more information, see Remove the ASM software in this
document.

If a newer version of ASM is shipped with an updated Asm.msc file, the existing Asm.msc file is renamed
to the Asm.sav.msc.

Caution:
Stop ASM before upgrading. No ASM snap-in (Windows) must be in use in any MMC console. To stop
ASM results in:

« Stopping automatic instances.
« Lose information of running processes.

An update to 64-bit ASM is supported if a 32-bit version of ASM was already installed but, some
restrictions apply. All versions before ASM 1.7 were 32-bit.

Caution:

You can update an old 32-bit version of ASM to a 64-bit version of ASM, but customized start-up
arguments for the Infor Application Service Manager service are lost upon update. For example; a
non-default specified listening port.

Permanently customizing startup arguments

1 Open a CMD window with administrator privileges, run as administrator..

2 Goto<home directory>\bin

3 Stop ASM with this command: asm_srv -stop

4 Re-install ASM with the required arguments, for example asm srv -install -p 8000

Temporary customizing startup arguments

1 Click Start > Administrative Tools > Services.
The service control manager starts.

2 Open the property page of the Application Service Manager and specify the required arguments in
the Start parameters field.

3 Restart the service to activate the parameters.
The temporary parameters get lost upon closure of this dialog box and upon reboot of the system.
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Chapter 3: ASM Server

This chapter describes the setup and use of the Application Service Manager server.

Running the server on UNIX

By default, the server runs as a daemon process. The asm_srv command starts a server that listens
to incoming commands on the specified port. You can assign a port number by the p parameter. If this
number is omitted, the server uses the default port 7250. With the h, or ? argument, you can display
Help information.

You can specify these parameters in the asm srv command on UNIX:

Parameter Description

-inherit Enable inherit of the system environment variables that were set
when the ASM server was started.

-k Stop server process (on UNIX)

-d Debug info (verbose output) for daemon asm_srv to stdout.

-p <port number> Override default TCP/IP listening port.

-home <home directory> Set program home directory for Application Service Manager

Server. This option is mandatory.

-r <time in seconds> Refresh interval for which Application Service Manager scans the
existence of the process for instances with Running status. Default
refresh time is 10 seconds.

-? or -h[elp] Display help/usage information

-V Version information

Starting a server that uses the default port 7250 run this command:
# asm srv -home <home directory>
Or use the rc.startasm script in the directory <home directory>/etc

To start an Application Service Manager Server that listens on port 7252 and inheriting environment
variables of current process run:
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# asm svr -home <home directory> -p 7252 -inherit
Or use the rc. stopasm script in the directory <home directory>/etc

To stop the server, you can stop the daemon. Do not forget to add the port number parameter if the
server does not use the default port:

# asm srv -home <home directory> -p 7252 -k

Ensure that you start the server with the correct installation directory, provided in the argument —~home
<home directory>.

The first time you start the Application Service Manager Server:
# ./asm_srv -home <home directory>
This message is displayed:

asm_srv: ASM daemon failed to read/open/parse configuration files. Please
refer to previous messages.

You can ignore this message. To verify if the server is running, use this command:
# ps -ef | grep asm srv

root 10598 1 0 Jan 7 ? 0:00 /home/bw/root/asm/bin/asm_srv -home
/home/bw/root/asm -p 7250

root 13944 1 0 Jan 2 ? 0:00 /home/root/bin/asm srv -home /home/root -d

root 26663 1 0 11:26:27 ? 0:00 ./asm srv -home <home directory> -p 7252

Running the server on Windows

At default, the installer configures the ASM Server. The ASM Server is installed as a Windows service.
The ASM is automatically started when a system is rebooted. To stop ASM you can use the Microsoft
Windows Service Manager.

The manual configuration of ASM Server on Windows is only required in these instances:

* You want to run ASM Server from a different port number.
* You must run ASM Server in debug mode for verbose output.

In these cases, you must start and configure ASM Server from the command line.

Starting the server on Windows
To start the ASM server, use the Windows service manager:

Click Start > All Programs > Control Panel Administrative Tools > Services > Application Service
Manager.
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Starting the ASM server

After you have installed the Application Service Manager server, you must configure the server. To
configure the server, you must start the server. This section describes the procedure to start the
Application Service Manager Server.

The method to start an Application Service Manager server on UNIX differs from a Windows computer.
Some elements are common, while others are platform specific.

The Application Service Manager server runs as a daemon on UNIX and as a service on Windows.
The server is represented by one single executable file called asm srv.
Follow these rules:

» To run the Application Service Manager server on a UNIX platform, you must have a root or super
user authorization. Ensure that only authorized personal can run the Application Service Manager
server or configure Application Service Manager.

* In all cases, including for Windows, UNIX, the -home <home directory > argument is mandatory.
For Windows, the installer creates this argument for you at default.

Manual startup of the server on Windows

For settings other than the defaults, such as occasional maintenance, and in case of, for example,
troubleshooting, you must use different command line options. You must start the ASM Server once
from the command line. After you start the ASM Server once with the required arguments. The arguments
are remembered the next time. Either by command line with (only) the -start argument, or by the
service manager.

This table lists the available command line options:

-inherit Enable inherit of the system environment variables that were set when the
ASM server was started.

-start Start asm srv service (if installed)

-stop Stop asm srv service (if installed)

-install Install asm srv service

-remove Remove asm srv service

-p[ort] <port number>  Override default TCP/IP listening port.

-home <home directo- Set program home directory for ASM Server. This option is mandatory.
ry>

-r <time in seconds> Refresh interval for which ASM scans the existence of the process for in-
stances with Running status. Default refresh time is 10 seconds.

-?, -h[elp] Display help/usage information
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-d Debug info (verbose output) for daemon asm_srv that is written to (typi-
cally) swindir$\temp\asm srv.log

-V Version information

To change the -home parameter, you must stop the ASM Server. Change the ~-home parameter and
restart the server with this new —~home parameter.

« If no additional arguments are provided to the start-stop or install command, the arguments of a
previous call are used. If the arguments were provided once, these arguments are used after a
reboot or through the Control Panel. If manual, these arguments are used from the command line.

» If you use the -d option, additional events are written in the Event Viewer. For example, the location
of the debug file is also shown in the Event Viewer. Check the events in the Event Viewer when the
ASM Server is started with the -d argument.
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Chapter 4: ASM MMC snap-ins

The installation process and the use of the Application Service Manager configuration tools are
described.

Using the Application Service Manager MMC snap-ins

Snap-ins are the individual management components loaded into the MMC as tools to help you perform
administration tasks. These Application Service Manager shap-ins are available for the MMC:

» Application Service Manager Cfg snap-in: With this snap-in you configure instances and services.
This snap-in requires a manual installation.

» Application Service Manager Snap-in: With this snap-in, you can monitor, start, or stop the instances.
This snap-in requires a manual installation.

Both snap-ins are implemented as an MMC snap-in and use the Microsoft Management Console. Note
that the interface can look slightly different for different MMC versions.

Prerequisites for ASM MMC snap-ins

To perform the installation of the Application Service Manager Ul snap-in on the client computers you
must meet these system requirements:

» A supported Windows version is used, see ASM platform OS availability.
» MMC version 3.0 or later is installed locally.

In addition, to use the snap-in, the Application Service Manager Server must also be available, either
locally or on a remote computer.
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LN snap-ins for MMC

Before you can use an Application Service Manager shap-in, you must save the MMC with ASM snap-in
to a MMC console file (optional).

To start the MMC console double-click the 2sm . msc file. By default, you can find this file in the directory:
<home directory>\bin\asm.msc
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Chapter 5: Configuring ASM

How to configure the Application Service Manager server.

Configuring services and instances

After the installation, you must configure the ASM server so you can use ASM to start or stop services
or sessions. To create services or sessions, you must use Ul-based utilities on a Windows system.
The user interface of Application Service Manager (Manager Ul) consists of a graphical ASM snap-in
that runs on the Microsoft Management Console (MMC).

Overview

With the ASM Cfg snap-in, you can manage the data that is related to servers and some configuration
settings of the ASM. For example, the servers that are currently in use.

The snhap-in uses a two-pane view that is similar to the Windows Explorer. The console tree is used
for navigation and selection and represents the hierarchical structure in which the data are stored. This
tree appears in the left pane, which is called the Scope pane. The Detail or List pane on the right
shows the content of what you select in the Scope pane.

The console tree contains nodes and items. Nodes are composite and consist of other nodes or items.
You can compare nodes to the folders in the Windows Explorer.

Items are components at the lowest level of the console tree, which do not contain other elements.
Items are similar to the files in the Windows Explorer.

Items are only visible in the Detail pane. All items have properties or attributes that are displayed as
columns in the detail pane. To adjust the column width, you can drag the margins of a column with the
mouse. To sort a column, click the column’s header. On the View menu, click Choose Columns to
select the properties that you require.
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Action menu

The Action menu contains several commands for the nodes and items in the console tree. The
commands that are available on the menu depend on what you select. The same commands are
available in the shortcut menu that appears if you right-click the node.

Nodes can also have properties, although not necessarily. Both items and nodes can have tasks and
various other features.

Configuring the ASM Server

Use AsmCfg Snapin to create specific services. With the ASM Snapin, you can stop or start these
services.

To configure the ASM Server:

1
2

5
6

Log off and return to the MMC console. To configure your snap-in, right-click AsmCfg Snapin.

On the shortcut menu, point to New and click New Host. You can also click Action from the menu
and make the same selection.

The Create a New Host dialog box is displayed. Specify the host and click Create.

Specify this information in the fields of the Specify Connection Data dialog box:

Host name:
Specify the name of the server which applications you want to control with the ASM.

Port number
Specify the port number on which the server’'s ASM receives commands. The search path determines
the server’'s ASM port number:

« The port number you specify at startup of the ASM.

« If you do not specify a port number at startup, ASM uses the port number defined for the logical
name BaanASM, in the file etc/services.

» If no port number is specified, ASM uses the default port number 7250.

If the value you enter in this field does not correspond to the server's ASM port number, the
MMC cannot command the server's ASM.

Time-out value(s)

Specify the MMC'’s time-out value, in seconds, for communication with the ASM daemon. The
default value is thirty seconds. For wide area networks, or if your ASM runs on a heavily loaded
server, you must increase this value.

Click OK.
Open the service types of the host you just configured. On the right pane, these types are displayed:

« Generic service types: Usable for every environment.
e Specific service types: Limited to a single environment.
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7

8

Right-click Generic Service Types, and on the shortcut menu that appears, point to New, and click
New Service Type to create a service type.

Specify a service type and click Create. The Specify Type Properties dialog box is displayed.
In this example, a service is created to stop and start the printer daemon.

Specify a Type Name and click the Start Attributes tab.

Specify the executable that starts an LN application service, for example, a command to start the
printer daemon.

Executable Name

The name of the executable that starts the application service, for example, the command to start
the printer daemon, ${BSE} /bin/pdaemont. 2

Executable Parameters

The service or session starts with the parameters you specify here. You can also leave this field
blank.

Session Code

Specify the session code of the session that the ASM must start. For example, the Activate Job
Daemon (ttaad5206m000) session, to start the job daemon.

Session Parameters

Overrules the default start parameters. The service or session will be started with the parameters
you specify here. You can also leave this field empty.

10 Click the Stop Attributes tab.

Specify this information:

Executable Name

The name of the executable that stops the application service, for example, the command to stop
the printer daemon, ${BSE} /bin/pdaemon6. 2

Executable Parameters

The service or session stops with the parameters you fill in here. You can also leave this field blank.
To stop the printer daemon specify -k.

Session Code
Specify the session code of the session that the ASM must start to stop.

Session Parameters
Overrules the default stop parameters. You can also leave this field empty.

11 Click OK to return to the MMC console.

The specific service types are limited to a single environment and have precedence over generic
service types if both exist with the same name. You do not have to specify the Stop Attributes.

You have now predefined in XML files the application services that the ASM can start, and sometimes,
stop. The services that you defined to be started, and for unique instances only, stopped by the
ASM, are called instances. To work with the services, you must configure the service instances.
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12 Right-click Service Instances.

13 On the shortcut menu that is displayed, select New, and click New Service Instance Host.

14 Specify a service instance and click Create. The Specify Host Properties dialog box is displayed.
15 Specify the host name where you want to stop or start the service and click OK.

16 Right-click the Host Name you just specified. On the shortcut menu that is displayed, point to New,
and click New Environment.

17 Specify the directory of the new environment, and click Create.
18 Specify this information on the Specify Environment Name and Directory dialog box:
e The environment Name. This name is shown in the left pane of the MMC console.
« The correct path name to the LN environment where you want the service type to start.
19 Right-click the environment you just created, and on the shortcut menu that appears, point to New,
and click New Service Instance.
20 Specify the name and click Create. The Specify Instance Properties page is displayed.
21 On the Service Instance Properties tab, specify this information:
Instance Name
Specify the appropriate instance name

Service Type
Select a service type.

Occurrence (Multiple)

Select the Multiple occurrence, when you can have multiple occurrences of the instance’ s application
service running simultaneously. The ASM can start a multiple occurring instance’ s application
service when requested by a user of an external software module. The user, and not the ASM,
stops the application service using the external software module. To communicate back to the ASM
server, Multiple instances must have an integration with ASM.

Occurrence (Unique)

Select the Unique occurrence, when you can only run one occurrence of the instance’ s application
service at a time. You can use the ASM to start or stop a unique occurring instance’ s application
service. For example, the ASM can start and stop a job daemon.

Stop and disable the Infor manager’s control of the job daemon service in the BSE when using the
ASM to start and stop a job daemon.

Startup (Automatic)

When you start the ASM, the ASM automatically starts the instance’s application service. You can
still manually command the ASM to stop and restart the instance’s application service.

Startup (Manual)
When a user sends the start command to the ASM, the instance’s application service starts.

User Name

Specify the OS name of the user to whom the system registers the instance’s application service,
when started by the ASM. If this user name is not a valid user name on the system, the ASM wiill
not start the application service.
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Password

Enter the OS password of the user that you entered in the User Name field. If the password is not
valid, the ASM will not start the application service. Ensure to update this field whenever the OS
password changes.

Retype Password
Re-enter the OS password of the user that you entered in the User Name field.

22 On the Start Attribute and Stop Attribute tabs, specify the fields to your requirements. Steps 9

and 10 list the descriptions of the tab’s fields.

23 Click OK. The instance is created and is displayed on screen.

To check the data before you send the data directly to the server, you can use the consistency
check. In this case, you can test the data and decide whether to save the data to the server.

Otherwise the server content is always refreshed without testing. On the shortcut menu that appears,
point to All Tasks and click Verify Consistency.

If you decide to save the data to the server, choose to save all your settings. Select the host name
and right-click the mouse. On the shortcut menu that appears, point to All Tasks and click Save
Service Types and Instances to ASM Server.

After you change the configuration settings, you must always restart your ASM Server to let the
changes take effect. You can stop and restart the server on UNIX with the rc.stopasmand rc.
startasm scripts.

You can also use these commands:
# <home directory>/bin/asm srv -home <home directory> -k
# <home directory>/bin/asm srv -home <home directory>

On Windows, you can restart the ASM Service with Microsoft’'s Services Manager. Click Start > All
Programs > Control panel > Administrative Tools > Services.

For more information, see Starting the ASM server.

ASM in combination with the LN installation

During an installation of LN together with the ASM software in one run, the Job Daemon is configured
automatically.

To modify these automatically configured files:

1
2

Start the ASM shap-in (asm.msc) and define the host in the AsmCfg Snap-in.

Right-click AsmCfg Snapin to configure your snap-in. On the shortcut menu that is displayed, select
New and click New Host.

You can also click Action from the shortcut menu and make the same selection. The Create a New
Host dialog box is displayed.

Specify the host and click Create. The Specify Connection Data dialog box is displayed.
Check the port number and time-out value (for example 7250 and 10).
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5 Click OK to complete the insert action.
The AsmCfg Snapin is configured with the jobdaemon information.

You must now follow the same procedure for the Asm Snapin. After the configuration, you can use
the jobdaemon service.

Proceed with Starting and stopping services on page 25.
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Chapter 6: Application Services

Here is described how you can use the ASM to start and stop application services.

Starting and stopping services

The Application Service Manager server is an administrative tool that you can use to start, and
sometimes, stop LN application services.

For example, with the Application Service Manager you can:

» Start and stop the job daemon: You can perform these steps either by Ul, using the MMC shap-in
called Application Service Manager snap-in, or from the command line with the asm_c11 utility, as
described in Management from command line on page 29 in this document.

You configured your MMC's Application Service Manager snap-in. To command the host's Application
Service Manager to start or stop unique instances. Specify this information:

* Host:
In the Details pane, or in the Tree pane, right-click a host, or select the host, and click the Action
menu. Point to All Tasks, and on the menu click:

« Start: To start all of the host’s unique stopped instances.
« Stop: To stop all of the host’s unique running instances.

» BSE:

In the Details pane, or the Tree pane, right-click a BSE, or select the BSE, and select the Action
menu. Point to All Tasks, and on the menu click:

« Start: To start all unique stopped instances of the BSE.

« Stop: To stop all unique running instances of the BSE.

» Instance:
In the Details pane, or the Tree pane, right-click an instance, or select the instance and click the
Action menu. Point to All Tasks and on the menu, click:
e Start: To start a stopped instance.
« Stop: To stop a running instance.

Note:
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* You cannot start or stop multiple instances with the MMC. You can only view the Application Service
Manager’s multiple instances with the status Defined.
» Stopping Application Service Manager will lose information about all running processes.

Various statuses of the Asm Snapin

For multiple instances:

» Stopped
» Defined

The status Defined signifies that a minimum of one multiple instance is started. This does not imply
that this multiple instance is also still running. An ASM client, such as OpenWorldX, itself triggers a
multiple instance when to stop. The ASM server has nothing to do with this process.

For unique instances:

» Stopped
* Running
* Unknown

The status Unknown signifies that the ASM server starts a unique instance and the start/stop command
that belongs to this instance finished the execution. This occurs if the unique instance runs another
command or forks itself to a background process with another process ID. The ASM server can no
longer find the process ID of the start/stop command. To prevent the ASM server from showing instances
with status Unknown, use commands that continue to run as a foreground process after starting. An
example of a process that forks to the background, and therefore, receives the Unknown status after
starting, is the LN printer daemon. Do not start this daemon from $ {BSE} /etc/rc.start pdaemon

At default ASM scans its running processing each 10 seconds. If a process was stopped, without ASM
got a stop request, the process is being marked with Unknown status.
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Appendix A: Troubleshooting

Here is described how to deal with error messages and other issues that can occur during the installation
or configuration of ASM.

Messages

The Application Service Manager Server creates messages due to configuration mistakes.

Error -2
e The BSE environment (path) is unknown.
* The instance is not found for the entered environment.

Error -4
* Incorrect path to executable for start command.
« Authentication failure (no permission to start).

Error -6
* Incorrect path to executable for stop command.
» Authentication failure (no permission to stop).

Error -8

« The Application Service Manager Server is not running. No connection was possible from a
client.

» The Application Service Manager Server was running, but on a port number other than the port
the client uses.

Not all possible causes for errors can be described here. In case of errors, for more information,
see the log files for UNIX, or check the Event Viewer for Windows. More detailed information is
displayed if you start the Application Service Manager Server in debug mode

To debug ASM server

In case of problems, you can see additional information when the -d argument is used.
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For Windows, the debug information is logged in %windir%\temp\asm_srv.log. The name of the debug
file appears in the Event Viewer.

For UNIX, the debug information is written to the console (stdout).
To start the server in debug mode on UNIX, type this command:

# asm srv -d -home <home directory>

On Windows:

# asm srv -start -d -home <home directory>
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Appendix B: ASM and the command line

With a command prompt, you can send commands to ASM through a command line interface.

Management from command line

Start, stop, and view the uniquely occurring instances defined for the ASM in any of your domain’s
BSEs.

View the multiple occurring instances defined for a host.

This table shows the commands for the command line.

Com- Action Additional Mandato- Additional Optional Com-
mand ry Commands mands
-l List all instances that are defined -h host
for the ASM -p port
-start Starts your selected instance. -i instance_name -h host
-e env.directory -p port

-uU user_name
-p pwd password

-stop Stops your selected instance -i instance_name -h host
-e env.directory -p port
-u user_name
-p pwd password

-start_all  Starts all the BSE’s unique in- -e env.directory -h host
stances -p port
-stop_all  Stops all the BSE’s unique in- -h host
stances -p port
-v |-V Displays the version information
for the asm_cli binary
-help Displays help for the asm_cli bina-
ry
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Specify the appropriate command for your platform:

* OnUNIX: asm cli
* On Windows: asm_cli.exe

Do not start instances of the type ‘multiple’ from the command line, which is uncommon. This type of
instance expects it can talk back to another application. If this type of talk back application is unavailable,
the started multiple instance does not respond. In general, external applications start multiple instances.
These external applications know how to communicate with such kind of instance.

Any user with a command prompt can send commands to the command line interfaces of the Application
Service Managers in their domain. For every server in your domain that has a BSE, you must restrict
the access, and executable permissions in the directory ${BSE} /bin, to trusted users.
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Appendix C: Remove the ASM software

These procedures describe how to remove the software. First, uninstall the server, then uninstall the
ASM MMC snap-ins.

Uninstalling the ASM Server on UNIX

In case of an installation failure or a change to the installation directory, you must complete these steps
to uninstall the ASM Server:

Stop the ASM Server and remove all ASM components manually.
For the list of ASM components see ASM software components.

Uninstalling the ASM Server on Windows

1
2
3

Stop the ASM Server and run the CMD window as administrator.

Change to the directory where the ASM Server was installed.

To stop and remove the server, run these commands:

¢ cd <home directory>/bin

° asmﬁsrv —remove

Toremove the bin\AsmCfgSnapin.dll andbin\AsmSnapin.dll files, you must first run these
commands:

* regsvr32 /u <home directory>\bin\AsmCfgSnapin.dll

* regsvr32 /u <home directory>\bin\AsmSnapin.dll

Remove all remaining ASM components.
For the list of ASM components, see ASM software components.

Note that the folder where ASM is installed, the <home directory>, contains more data. For
example, files for the Solution License Manager. Be careful when you delete files in this directory.
For a complete list of files for each platform, see the table in ASM software components
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Appendix D: Environment variables

Why and how to set environment variables.

In some specific cases, you must specify environment variables for the ASM server. These variables
are required in these cases:

An instance started by the ASM server can require an LN environment variable. An environment
variable can be set system wide. All LN environments that are installed on the system, and using
the same environment variable are forced to use the same (value for this) variable. For example, a
bshell must load a shared library for a third-party product, such as the database driver. In this case
you must set the appropriate environment variables. On a Windows platform, you must set the
environment variable as a system environment variable. A user environment variable will not be
recognized by ASM. If you have set a system wide environment variable, you must reboot your
system to activate the variable. Any subsequent process that is started by an ASM instance is
assumably accessible by the PATH variable if not qualified with a full path name. At default, the
ASM instances do not inherit system environment variables (of the user that starts the ASM server).
Use the -inherit flag to inherit system or service environment variables by ASM instances.

On Windows, the ASM Server runs in the context, and with the same environment, in which the
server was started. Therefore, on Windows, the ASM Server runs in system context, and has the
variables of that specific system environment.

On UNIX, no environment variables are defined if the ASM Server was started from, for example,
boot time. Environment variables are only available on UNIX after you start working from a shell,
such as korn shell or bourne shell and so on. To overcome these problems, start the ASM Server
from a shell with the correct environment variables defined. Remember that the shell may affect
argument passing. Use for ksh for example; "$@" (with quotes) instead of $*. Check the manual
page of ksh for more information.

We do not recommend that you use a system wide set environment variable. Use a shell script or
batch file to set the variable. For LN Environments, you can also set variables per LN environment
with the Infor Manager snap-in.

Example Set your environment variables

Set your library variable on the server if you use the:

Web Ul framework to connect to the LN environment.
Java Development Kit or Java Runtime Environment.
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On an AIX machine, the variable is the LIBPATH variable. On all other UNIX systems, the variable is
called the LD LIBRARY PATH variable. The operating system dependent variable must be set using
a shell, for example, korn shell, before the ASM Server is started.

Note:

All environment variables that are defined at startup of the ASM Server are system-wide settings. These
variables are valid for all instances and types that are defined. You can also set environment variables,
required for one instance, an application, or shell scripts for UNIX only. In LN you can use the Infor
Manager snap-in to set the environment variables.
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Appendix E: ASM platform OS availability

See for the support matrix, support Java versions and Virtualization support the last version of the Infor
Enterprise Server Support Matrix for porting set (U9757). The last version of this document can be
found in KB 1183466 on the Infor Support Portal.
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Appendix F: Starting the tmboaserver through ASM

To start and stop the tmboaserver with ASM, you can use this section to specify the correct information.
To create a new Service type and Service Instance use the procedure as described in Configuring
ASM on page 19.

The sessions which are used most to start are:

» Multiple occurrence (runs forever unless killed):
» tmboaasmserver

» Unique occurrence:
» job daemon (ttaad5206m000/ttaad5207m000) (with start and stop function)
» job (ttaad5203m000) (only with start function)
* tmboaserver (with start and stop function)

This table shows the information for the tmboaserver:

Service Type properties tab specify the name tmboaserver

On the Start Attributes tab

Executable Name ${BSE}/bin/bshell6.2
Executable Parameters -server

Session Code tmboaserver

Session Parameters -d

On the Stop Attributes tab

Executable Name /usr/bin/java

Executable Parameters -Xrs -cp ${BSE}/java/ow.jar:${BS
E}/java/ow3p.jar:${BSE}/java

Session Code com.baan.owtools.BackendControl

Session Parameters -d

This table contains the information for the server instance:

Service Instance Properties
Instance Name Specify the appropriate instance name

Service Type tmboaserver
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Service Instance Properties
Occurrence

Startup

User Name

Password

On the Start Attributes tab
Overrule Executable Parameter
Extra Executable Parameter
Overrule Session Parameter

Extra Session Parameter

On the Stop Attributes tab
Overrule Executable Parameter
Extra Executable Parameter
Overrule Session Parameter

Extra Session Parameter

Unique
Manual
bsp

Specify the OS password of the user that you spec-
ified in the User Name field.

Do not select
-dbgjvmi
Do not select

-busc <Buscomponent> -1 log.tmbo
a -s

Do not select
Do not select
Do not select

-busc <Buscomponent> -action dea
ctivate
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